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Supplementary Materials and Methods 
 
DNA origami design and assembly 
The DNA origami AFM fiducial structure was designed using caDNAno1 (design schematics 
in Figure S1). The staircase-like structure consists of eight layers of parallel helices packed on 
a square lattice. The designed length of the structure is 200 base pairs, the width is ten helices. 
The number of DNA helices in the layers is varied to obtain four discrete steps with equal x-y 
areas and heights of one, two, five, and eight helices. Sequences and the caDNAno design of 
the DNA origami AFM fiducial structure can be found as AFMRuler.xls and AFMRuler.json 
as a part of the zip archive AFMRuler.zip in the Supporting Information. The x-y dimension 
of each step in our design is approximately 17 nm × 20 nm (50 bp×10 helices), which 
provides a sufficient number (>20 points per height plateau) of independent measurement 
points for calibration2 and ensures mechanical stability during the AFM measurement. We 
used the square lattice geometry and corrected the design for internal twist3, 4 to obtain a flat 
surface of the ‘stairs’. 
Design-specific staple strands were purchased from IDT Technologies, the scaffold strand 
p8634 was produced from M13 phage replication in E. coli. Scaffold strand and staple strands 
were mixed at 1:5 scaffold:staple ratio with target concentrations of 30 nM and 150 nM (each 
staple), respectively in 10 mM Tris Base, 1 mM EDTA buffer with 18 mM magnesium 
chloride (TE/Mg2+). 50 µL volumes of staple/scaffold mixture were heated up to 65°C for 5 
min and annealed from 65°C to 20°C at -0.2°C/min in a PCR machine. The DNA origami 
structures were purified from excess staples using 100 kD molecular weight cut-off filters 
(Amicon Ultra-0.5 Centrifugal Filter Units with Ultracel-100 membranes). The 24-helix-
bundle (24HB) structure5 was folded in a similar fashion using the p8064 scaffold strand and 
purified using the PEG precipitation method adapted from Wagenbauer et al.6. 
 
TEM sample preparation and imaging 
5 µL of sample solution was incubated for 30 s – 5 min, depending on concentration, on glow 
discharged TEM grids (formvar/carbon, 300 mesh Cu; Ted Pella) at room temperature. After 
incubation on the grids, the sample was wicked off by bringing the grid into contact with a 
filter paper strip. Samples containing DNA origami went through an additional staining step 
with a 2% uranyl formate aqueous solution containing 25 mM sodium hydroxide. After 
incubating and wicking the sample off, a 5 µL drop of staining solution (2% uranyl formate 
aqueous solution containing 25 mM sodium hydroxide) was applied to the grid, immediately 
wicked off, followed by applying another 5 µL drop of staining solution. This drop was 
allowed to incubate on the grid for 10 seconds and then wicked off. The grid was allowed to 
dry for 5 minutes before imaging. Imaging was performed with a JEM1011 transmission 
electron microscope (JEOL) operated at 80 kV. 
 
Synthesis of SiO2 nanoparticles 
Silica particles were synthesized with a one-step synthesis based on previous literature7, 8. All 
glassware was etched of residual silica via a base bath (2−3 days in a saturated solution of 
KOH in isopropanol, rinsed with milliQ water). The particles were synthesized as follows: in 
a 500 mL 1-neck flask, 181 mg (6 mM) L-arginine (98%, Sigma-Aldrich) were dissolved in 
169 mL milliQ water. The mixture was heated to 30 °C and stirred slowly (200 rpm). After 1 
h, 11.2 mL (49 mmol) TEOS (tetraethoxysilane; 98%, Sigma-Aldrich) was added slowly via 
the wall and a two layered system formed (top: TEOS, bottom: water). The reaction mixture 
was stirred for 1 week to complete the synthesis. The resulting particles were stored at room 
temperature in the dark and used without further processing. 
 
 



AFM sample preparation 
For the AFM samples, we deposited 20 µL of a buffered solution (10 mM Tris Base, 12.5 mM 
MgCl2,1 mM EDTA, pH 8.35; AFM buffer) containing the fiducial structures (at different 
concentrations between 1 and 10 nM) either on freshly cleaved bare muscovite mica or on 
aminopropylsilatrane (APS)-coated mica or poly-L-lysine coated mica. The sample was 
incubated 5 minutes before washing with 20 mL milliQ water and drying with a gentle stream 
of filtered argon gas. The APS coating was performed following the protocol from 
Shlyakhtenko et al.9. The poly-L-lysine coated mica was prepared as described previously10 
by depositing 20 µL 0.01%-poly-L-lysine on freshly cleaved muscovite mica for 30 seconds 
and subsequently rinsing the surface with 30 mL of milliQ water before drying with a gentle 
stream of filtered argon gas.  
For the liquid measurements, 2.5 mL of the buffered solution was added to the sample after 
incubation. For the co-deposited samples, we pre-mixed the fiducial structures with the 
corresponding sample (at varying concentrations between 1 and 10 nM) prior to deposition in 
AFM buffer. The samples were incubated, washed, and dried as described above.  
For the DNA-protein complex sample, we first mixed linearized plasmid pU3U5 (4.751 kbp; 
Mini-HIV DNA, see Cherepanov et al.11) with HIV-I IN in sodium buffer (10 mM Tris-HCl, 
90 mM NaCl; 5 mM MgCl2) to a final concentration of 1 ng/ul DNA and 1 µM of protein. 
Next, we added the fiducial structures at a final concentration of 1 nM and deposited 20 µL of 
the mixture on APS-coated mica. The sample was incubated, washed, and dried as described 
above. 
 
AFM imaging 
The dry AFM images were recorded in tapping mode at room temperature using the 
Nanowizard Ultraspeed 2 (JPK, Berlin, Germany) with silicon tips (FASTSCAN-A, drive 
frequency 1400 kHz, tip radius 5 nm, Bruker, Billerica, Massachusetts, USA). Images were 
scanned over different fields of view and with various pixel sizes (indicated for each image) 
with a scanning speed of 5 Hz. The free amplitude varied from 20 to 30 nm. The amplitude 
setpoint was set to 80% of the free amplitude and adjusted to maintain good image resolution.  
The liquid AFM images were recorded in peak-force tapping mode at room temperature, also 
using the Nanowizard Ultraspeed 2 (JPK, Berlin, Germany) with silicon tips (BL-AC40TS, 
drive frequency 25 kHz in water, tip radius 10 nm, Olympus, Tokyo, Japan). Images were 
scanned over different fields of view and with various pixel sizes (indicated for each image). 
The peak force was set to 200 pN. For some measurements we use an external polycrystalline 
tip characterization sample (PA01 AFM Tip Evaluation Sample, NanoAndMore GmbH, 
Wetzlar, Germany) with hard sharp pyramidal nanostructures with base length in the range 50 
- 100 nm and height 50 - 150 nm, and radius of curvature of the sharpest edges below 5 nm. 
 
AFM image analysis 
For this work, postprocessing of AFM data was performed in the software SPIP (v.6.4, Image 
Metrology, Hørsholm, Denmark), which has implemented blind peak reconstruction as well 
as image deconvolution following Villarrubia's protocol12. We note that while we used SPIP 
for all image processing, other AFM post-processing softwares, such as Gwyddion, have also 
incorporated blind tip reconstruction routines with implementations very similar to SPIP. 
Here, we will give detailed instructions for tip characterization and image reconstruction for 
SPIP and Gwyddion. An example of a fiducial image recorded with a FASTSCAN-A 
cantilever can be found in Image_Reconstruction_Example_SPIP_Gwyddion.zip as 
Supporting Data, the resulting reconstructed images are also shown in Supplementary Figure 
S7.  
 
AFM postprocessing with SPIP 



First, the images were flattened (Modify → Global leveling) and line-wise leveled (Modify → 
Linewise leveling). Next, the tip was characterized via blind tip reconstruction. To this end, 
we either used the entire image or (in case of co-deposition or contamination of the sample) 
selected a subset of fiducial structures (General → Area of interest). Next, we used the tip 
characterization tool (Analyze → Tip) and specified the tip size in x and y as number of pixels 
(Tip characterization → Size X and Y). For FASTSCAN-A cantilevers, we took the 
manufacturer’s specified tip radius of 12 nm as a starting point for the blind tip reconstruction 
(for example, for a FASTSCAN-A cantilever with a tip diameter of 24 nm and an image 
resolution of 1.6 nm/pixel, the tip size would correspond to 15 pixels). We typically used 5 
iterations (more iterations did not to improve tip reconstruction in our experience, but could 
be an option for troubleshooting the procedure, e.g. for a particularly challenging sample). 
The resulting tip shape was saved (Tip characterization → Save tip) and then loaded (Tip 
characterization → Load tip) to correct (Tip characterization → Deconvolute) the same or 
another image scanned by the same tip. Here, too, the tip size had to be adjusted to the 
corresponding size in pixel so that the resolution is not lost (Tip characterization → Size X 
and Y). As a useful quality control, SPIP also calculates an uncertainty map. In this map, the 
areas of the image where the tip did not touch the surface in a single point, but in multiple 
points (so not with the tip apex but with the side), are highlighted in red, so that, for example, 
a larger area is shown in red when a blunt tip is used than when the same area was scanned 
with a sharp tip. 
 
AFM postprocessing with Gwyddion 
Gwyddion is an open source software for scanning probe microscopy data visualization and 
analysis (http://gwyddion.net/). Post-processing of AFM data in Gwyddion works very 
similarly to SPIP. Tip reconstruction in Gwyddion using the blind tip reconstruction 
algorithm is described in detail in the Gwyddion online user guide: 
http://gwyddion.net/documentation/user-guide-en/tip-convolution-artefacts.html.  
In brief, the images first need to be flattened (Data process → Level → Plane level) and line-
wise leveled (Data process → Correct data → Align rows (Polynomial degree 2, Direction: 
horizontal)). In the case of co-deposition, at least 10 fiducials are selected with one or several 
masks (Tools → Edit mask (Mode: add selection to mask)). As a prerequisite for blind tip 
reconstruction, the tip is first modeled (Data Process → SPM modes → Tip → Model tip) 
using the manufacturer's tip specifications (for example for a FASTCAN-A cantilever, Tip 
type: pyramid, Number of sides: 3, Tip slope: 15°, Tip rotation: 0°, Tip apex radius: 10 nm). 
Next, the tip is characterized using the blind tip estimation algorithm (Data Process → SPM 
modes → Tip → Blind Estimation). The blind tip estimation window opens where the related 
data (the previously modeled tip) is chosen and the tip size in pixel is specified. The tip size in 
pixel is given by the resolution (in pixel/nm) multiplied by the size of the tip (in nm; which 
can be e.g. obtained from the vendor’s specifications). The resolution of the image can be 
viewed in Tools → Statistical quantities. The noise suppression threshold was set to 100 pm, 
this value strongly depends on the sample and image quality and can be adjusted according to 
the noise level.  
We recommend to first carry out partial tip estimation and to use the result as input for the full 
tip estimation run. First, partial tip estimation, which uses only a limited number of the 
highest points in the image, is applied (Blind tip estimation → Run partial), and then full tip 
estimation (Blind tip estimation → Run full), which uses the entire image. This way, the 
results of the partial tip estimation are used as a starting point for the full estimation and the 
speed of the full tip estimation is improved. The tip is saved automatically (after clicking Ok). 
Next, the estimated tip shape is used to correct the same or another image (Data Process → 
SPM modes → Tip → Surface reconstruction) – note that the scan pixel size needs to be the 
same as tip image pixel size (the physical pixel size can be matched manually: Data Process 



→ Basic Operations → Resample → Match pixel size). Also in Gwyddion, a certainty map 
can be calculated to view the areas that were not scanned by the apex of the tip but with a side 
of the tip (Data Process → SPM Modes → Tip → Certainty Map). We note, that in our 
experience the blind tip reconstruction in Gwyddion depends more strongly on the starting 
values (model tip) than the implementation in SPIP.  
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Table S1. Dimension analysis of the DNA origami fiducial structure 
Comparison of the design dimensions to the dimensions measured in TEM, dry AFM, and 
liquid AFM. Not all features were consistently visible in the different techniques and are 
therefore not listed. For the TEM data, the mean and standard deviation are listed. Details 
about the analysis and the raw data can be found in Supporting Information Figure S1. For the 
dry and liquid AFM data, Gaussians are fitted to the data (Supporting Information Figure S4) 
and here the mean and standard deviation of the distribution are listed. We note that the height 
values are averaged over the full width of the structure. 
 
 
  

Parameter Design TEM Dry AFM Liquid AFM 
Width W 10 

helices 
23 ± 1.2 nm 32.3 ± 1.6 nm 

(original) 
23.3 ± 1.4 nm 

(reconstr.) 

30.0 ± 2.2 nm 
(original) 

28.8 ± 2.9 nm 
(reconstr.) 

Height H1 1 helix - 0.65 ± 0.3 nm 0.55 ± 0.4 nm 
Height H2 2 helices 5.3 ± 0.8 nm 2.1 ± 0.4 nm 2.0 ± 0.5 nm 
Height H3 5 helices 12 ± 1 nm 5.4 ± 0.4 nm 9.4 ± 1.4 nm 
Height H4 8 helices 19 ± 1.2 nm 8.0 ± 0.4 nm 15.9 ± 1.1 nm 

Interhelical spacing 
(vertical) 

 2.3 ± 0.1 nm 1.1 ± 0.2 nm 2.0 ± 0.2 nm 



Supplementary Figures 
 

 
Figure S1. CaDNAno layout of the DNA origami AFM fiducial structure design.  The 
DNA origami AFM fiducial structure was designed using the open-source software 
caDNAno1. The structure consists of four levels, the first two comprising one DNA layer 
each, the second and fourth three layers each, resulting in a total of eight layers. The DNA 
helices are arranged in parallel on a square lattice.  



 
 
 

 
 
Figure S2. Dimension analysis of the fiducial structures based on TEM images. a) Design 
of the fiducial structure indicating the design dimensions and labelling of the lengths and 
heights. b) Height distribution for the 3 highest levels of the fiducial (the lowest level H1 was 
not visible in the TEM images; see Table S1 for a detailed dimension comparison). c) Length 
distribution for the levels 1, 3, and 4 of the fiducial (length L2 was not clearly visible in the 
TEM images). d) Width distribution of the fiducial. 
 
  



 
Figure S3. Comparison of AFM images obtained with different surfaces deposition 
approaches. a) Top: AFM height image of fiducial structures at a concentration of 10 nM 
deposited on a) Mg2+ mica, b) PLL mica, c) APS mica, after drying in air. Bottom: Same 
images as in top row after reconstruction. The scale bars are 100 nm. Z-ranges are indicated in 
nm by the scale bars on the right. We note that the variability in image quality visible in the 
data is mostly due to tip-to-tip variability and not systematically dependent on the deposition 
method. d) Relative frequency of deposition orientations for Mg2+ mica dry, PLL mica dry, 
APS mica dry, and APS mica liquid. For all tested deposition strategies, the staircase-like 
orientation is preferred. Only for AFM images acquired in liquid, fiducials lying on their sides 
or standing upright were also observed in relevant quantities. For all conditions, >300 
fiducials from at least three independent measurements were analyzed. The error bars were 
obtained from counting statistics. 



 
 
Figure S4. Dimension analysis of the fiducial structures based on AFM images. a) Height 
distribution for the 4 different levels of the fiducial from dry AFM images and Gaussian fits 
(solid lines) with Gaussians. b) Height distribution for the 4 different levels of the fiducial 
from liquid AFM images and Gaussian fits (solid lines). See Table S1 for a detailed 
dimension comparison. c) One exemplary fiducial height profile from dry AFM imaging. d) 
One exemplary fiducial height profile from liquid AFM imaging. e) Height per DNA layer 
and total height as a function of the number of DNA layers in the DNA origami for dry AFM 
imaging. f) Height per DNA layer and global height as a function of the number of DNA 
layers in the DNA origami for liquid AFM imaging. The red lines in e and f indicate linear 
fits. The reported heights are averaged over the full width of the structure. Consequently, the 
height values represent averages over the helices and the gaps between helices and are, 
therefore, lower than what the diameter of DNA. 
 
  



	    
Figure S5. AFM tip characterization using different AFM FASTSCAN-A cantilevers. a) 
Top: AFM height image of fiducial structures at a concentration of 5 nM on APS mica, 
measured dry. Total image size is 500 x 500 nm2 and 512 x 512 pixels. The scale bars are 50 
nm. The Z-ranges are indicated in nm by scale bars on the right. One exemplary fiducial 
structure is shown as a zoom-in as well as its height profile underneath. Third row: 
Reconstructed image of the AFM image shown in the first row. Fourth row: scan of a 
polycrystalline sample with the same tip. Total image size is 1 x 1 µm2 and 1024 x 1024 
pixels. Fifth row: Reconstructed image of the AFM image shown in the forth row. The scale 
bars are 50 nm. The Z-ranges are indicated in nm by scale bars on the right. Sixth and seventh 
row: AFM tip shape (height profile along x- and y) obtained from blind tip reconstruction 
using the fiducial sample or the polycrystalline sample, respectively. As a reference, the tip 
opening angles stated by the vendor are co-plotted as dashed lines. b) – e) Analogous to panel 
a for different FASTSCAN-A tips from the same batch. The data suggest considerable 
variation between tips; Tips used for panels a and b enabled high-resolution images and 
reconstructed tip shapes using our fiducial are close to vendor specifications. Tips used for 
panels c-e appeared less sharp and gave only lower-resolution images.  



 
 
Figure S6. Width analysis of SiO2 nanoparticles based on TEM images and co-
deposition with fiducial structures in AFM with height analysis. a) TEM image of SiO2 
nanoparticles to determine size and shape. Yellow lines indicate cross-sections used for size 
analysis. b) Width distribution of the SiO2 nanoparticles from the TEM image shown in panel 
a with a mean and standard deviation of (11.5 ± 1.2) nm. c) AFM height image of the fiducial 
structures co-deposited with SiO2 nanoparticles, both at a concentration of 1 nM, deposited 
on APS mica and measured dry with a resolution of 1 pixel/nm. Exemplary fiducials and 
nanoparticles are indicated with magenta and yellow arrows, respectively. The scale bar is 50 
nm. The Z-range is indicated in nm by the scale bar on the right. d) Height distribution from 
AFM images before (turquoise) and after (orange) image reconstruction. The solid lines are 
Gaussian fits. The mean height in the original image of (12.8 ± 1.3) nm (mean ± std) does not 
change within error after image reconstruction (12.4 ± 1.5) nm by finite tip size correction. 
  



 
 
Figure S7. Comparison of AFM image reconstruction softwares. a) AFM height image of 
fiducial structures at a concentration of 10 nM deposited on APS mica, after drying in air 
(same image as shown in Supplementary Figure S3c top). b) The image from panel a after 
reconstruction with the software SPIP (same image as shown in Supplementary Figure S3c 
bottom). c) The image from panel a after reconstruction with the software Gwyddion. The 
scale bars are 50 nm. Z-ranges are indicated in nm by the scale bars on the right. The three 
images shown in this figure are provided as Supplementary Data in the file 
Image_Reconstruction_Example_SPIP_Gwyddion.zip. 
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